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Preface 

Methodical recommendations for laboratory work in the "Local Networks" 

discipline are intended for candidates of the degree "Bachelor" of specialties 

"Computer Engineering" and "Cybersecurity" of foreign origin. 

The guidelines present seven laboratory tasks devoted to the study of local 

networks based on simulation models created in NetCracker Professional using 

different technologies: Ethernet, Switched Ethernet, Fast Ethernet, Switched Fast 

Ethernet, Token Ring, Switched Token Ring, FDDI. Methodical recommendations 

contribute to the achievement of the following learning outcomes:  

• development of local area network structures using various technologies; 

• implementation of physical and logical structuring of local networks; 

• performing local network configuration assessment; 

• organization of research of parameters and characteristics of local networks 

on the basis of created simulation models; 

• analysis of the application of various network technologies on the basis of 

research on appropriate simulation models. 

Each laboratory work provides an example (based on option № 43) to create a 

simulation model of the relevant technology, as well as report requirements, control 

tasks and questions on the protection of laboratory work. Preparation for laboratory 

work involves the development of lecture material on the "Local Networks" subject 

and the implementation of tests for self-control in the distance learning "Lider" 

system [2]. As the main source, the textbook [3] is recommended, as an additional 

source - [1] and videos on the creation of simulation models, set out in [2]. The 

teacher developed a methodology for the formation of competencies of degree 

training of IT professionals in the railway industry and presented in [5], in particular 

the formation of competencies in bachelors in distance learning in the "Local 

Networks" discipline, which is presented in [4]. 
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Laboratory Work № 1 

CONSTRUCTION OF A SIMULATION MODEL OF A LOCAL NETWORK 

WITH THE USE OF THE ETHERNET TECHNOLOGY 

Objective:  1. Getting acquainted with the Ethernet technology. 

    2. Learning the specifications limitations of the Ethernet physical layer. 

    3. Mastering the method of calculation of PDV and PVV. 

   4. Acquiring practical skills of physical structuring of Ethernet network. 

1. Individual task 

Task description: on the basis of the given infrastructure (according to the 

variant of the individual task, Tab. 1.1–1.3) by means of the NetCracker Pro program, 

design a network on the basis of the Ethernet technology, estimate its loading, 

response time and cost. 

Table 1.1  

Variants of individual tasks 

Vari- 
ant 
№ 

Infrastruc-
ture type 

Traffi
c type 

Vari-
ant
№ 

Infrastruc-
ture type 

Traffic 
type 

Vari- 
ant 
№ 

Infrastruc-
ture type 

Traffic 
type 

1 1 1 28 4 4 55 7 7 

2 2 1 29 5 4 56 8 7 

3 3 1 30 6 4 57 1 8 

4 4 1 31 7 4 58 2 8 

5 5 1 32 8 4 59 3 8 

6 6 1 33 1 5 60 4 8 

7 7 1 34 2 5 61 5 8 

8 8 1 35 3 5 62 6 8 

9 1 2 36 4 5 63 7 8 

10 2 2 37 5 5 64 8 8 

11 3 2 38 6 5 65 1 9 

12 4 2 39 7 5 66 2 9 

13 5 2 40 8 5 67 3 9 

14 6 2 41 1 6 68 4 9 

15 7 2 42 2 6 69 5 9 

16 8 2 43 3 6 70 6 9 

17 1 3 44 4 6 71 7 9 

18 2 3 45 5 6 72 8 9 

19 3 3 46 6 6 73 1 10 

20 4 3 47 7 6 74 2 10 

21 5 3 48 8 6 75 3 10 

22 6 3 49 1 7 76 4 10 

23 7 3 50 2 7 77 5 10 

24 8 3 51 3 7 78 6 10 
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25 1 4 52 4 7 79 7 10 

26 2 4 53 5 7 80 8 10 

27 3 4 54 6 7    
        

 
Table 1.2  

Infrastructure type  

Vari-
ant № 

Number of 

buildings 

Distance between  
buildings 

Number of 
floors 

Number of rooms 
on the floor 

1 2 300 4 4 

2 2 250 3 3 

3 3 200 3 3 

4 3 150 2 4 

5 4 150 2 3 

6 4 200 3 2 

7 5 100 3 2 

8 5 150 2 3 
          Table 1.3  

Simulated traffic type 

Vari- 
ant № 

Number of 

file servers 

Number of 

НТТР- servers 

Number of 

FTP- servers 

Number of 

data bases servers  

1 3 1 2 4 

2 3 2 1 3 

3 3 1 2 2 

4 2 2 1 1 

5 2 1 2 4 

6 2 2 1 3 

7 4 1 2 2 

8 4 2 1 1 

9 4 1 2 4 

10 2 2 1 3 

2. Sequence of execution 

1. Get acquainted with Ethernet technology (access method to the CSMA/CD 

transmission environment, MAC-sublayer parameters, restrictions on physical layer 

standards). 

2. Study the purpose of the communication equipment of physical structuring 

of the network, the general and distinctive properties of the repeater and hub. 

3. Get from the teacher a variant of the individual task (Table 1.1–1.3). 

4. Choose a physical environment for horizontal, vertical and campus 

subsystems; justify the choice. 
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5. Perform an analysis of all the limitations of the standards in accordance with 

the chosen physical environment; justify the choice of communication equipment for 

the physical structuring of the Ethernet network. 

6. Check the configuration the correctness of the received Ethernet network. 

7. Determine the "threshold" of Ethernet on the simulation model: the number 

of workstations, the intensity of requests, the length of the frame. 

8. Calculate the cost of the built Ethernet network. 

9. Run on the Ethernet simulation model. Analyse the average load of the 

network equipment and the data transmission environment as well as the response 

time for the data flow. Specify areas of the network that are vulnerable to overloads. 

10. Make a report on laboratory work: 

– theme  and objective of laboratory work; 

– initial and additional data; 

– substantiation of the required amount of communication equipment and its 

brief characteristics; 

– Ethernet network structure (with indication of distances, servers locations 

and communication equipment); 

– calculation of PDV and PVV (if necessary); 

– found the "threshold" of Ethernet performance; 

– calculation of the cost of Ethernet; 

– printout of the report with the definition of the average load of the network 

equipment and data transmission environment as well as the response time for the 

data flow; 

– conclusions.  

3. Example of laboratory work execution 

3.1. Development of the Ethernet structure. According to the variant (see 

Table 1.1): the type of the infrastructure – 3 (see Table 1.2); the type of the simulated 

traffic is 6 (see Table 1.3). Additional information: floor width is 18 m; floor height is  

3 m. For the campus subsystem (external environment) the best type of cable is fiber-

optic; the distance between houses is 200 m which does not exceed the limit on the 

length of the physical segment of 2000 m. For vertical and horizontal subsystems, 

one of the possible options is using UTP Cat 3. The structure of the designed 

computer network is shown in Figure 1.1. 

It is advisable to place all servers in one room (server room); let it be in the 

Building (floor 2, room 2). 

Since the Ethernet computer network (see Figure 1.1) uses different types of 

segments, it is necessary to evaluate its configuration. 

1. The total number of workstations is 35 that does not exceeding 1024. 
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2. The length of the physical segments of the fiber-optic cable is 200 m 

(campus subsystem), and the twisted pair from 3 m to 11 m (vertical and horizontal 

subsystem) that does not exceeding the limit of 2000 m and 100 m accordingly (see 

Table 1.1) . 

3. Calculate the value of PDV between the most remote stations Workstation 

22 and Workstation 21 (see Figure 1.1).  

 

Fig. 1.1. The structure of the designed computer Ethernet network 

Since the left and right segments are of the same nature, the calculation is 

performed only once (from left to right). 

I segment (left) on 10Base-T, 11 m: 

543,16113,0113,15 =+  bt; 

II segment (intermediate) on 10Base-FL, 200 m: 

5,531,02005,33 =+  bt; 

III segment (intermediate) on 10Base-FL, 200 m: 

5,531,02005,33 =+  bt; 

IV segment (right) on 10Base-T, 11 m: 
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243,166113,011165 =+  bt. 

 The total value of PDV is: 

16,543 + 53,5 + 53,5 + 166,243 = 289,786 bt < 575 bt. 

 

4. Calculate the PVV value between Workstation (22) and Workstation (21) (see 

Figure 1.1): 

I segment (transmitting) on 10Base-T: 10,5 bt; 

II segment (intermediate) on 10Base-FL: 8 bt; 

III segment (intermediate) on 10Base-FL: 8 bt. 

PVV calculation is also performed once (from left to right). The total value of 

PVV is: 

10,5 + 8 + 8 = 26,5  bt < 49  bt. 

All conditions are met, i.e. the configuration of the projected computer network 

is correct. 

3.2. Building a simulation model of Ethernet in NetCracker Pro. Launch 

the program. Create a new project: File → New ( ). Save a new project at once: 

File → Save (  ), choose a storage folder and press OK. When creating a project, 

the Top window is opened. In the Devices (on the left panel) choose Buildings, 

Campuses and LAN Workgroups. From the bottom of the window, drag the Campus 

to the clear field of the Top window ( ).To place houses on Campus, click the 

right button of the mouse on Campus and select Expand from the context menu. A 

new Campus window will be opened. From the bottom panel of Devices drag  

on a clear field of the Campus window. Thus, the result of the action is presented in 

Figure 1.2.  

  

Fig. 1.2. Creating the Campus subsystem 
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By analogy, three floors are needed to be made in each house ( , Figure 

1.3.), with three rooms on each floor ( , Figure 1.4). 

                       

Fig. 1.3. Creating a vertical subsystem  Fig. 1.4. Creating a horizontal subsystem 

The structure of the network can be viewed on the Project Hierarchy (the left 
panel), as it is shown in  Figure 1.5. 

  

Fig. 1.5. The structure of the network 

In the server room (with the Expand command), put the hub LinkBuilder ECS 

4-slot (left panel: Hubs → Shared media → Ethernet → 3Com Corp. → LinkBuilder 

ECS 4-slot); click on the name once and drag the hub from the bottom to the room. 

You need to add modules with slots to the hub: two modules 12-Port 10BaseT 

Repeater Mode; one 6-Port FOIRL Repeate Module, IMF ST. To add a module to the 

hub, you need to drag the module from the bottom panel to the hub. For viewing, do 

the double-click on the hub with the left button of the mouse or click the right button 

using the Configuration command. As a result, the LinkBuilder ECS 4-slot hub has 

three modules, as it is shown in  Figure 1.6. 
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Fig. 1.6. The structure of LinkBuilder ECS 4-slot hub  

Eight Ethernet Servers (optional) from the LAN servers panel (on left) must be 

located in the server room. 

Click once on LAN servers; drag the Ethernet Server from the bottom part 

eight times into the room. Now you need to make servers for a specific purpose. To 

do this, insert a disk into the server: Network and enterprice software → Server 

software. Click once on Server software with the left button, several disks will appear 

at the bottom part, we need: two File servers, one FTP server, two HTTP servers and 

three Small office database servers. Add one disk to each server and rename the 

server accordingly (to rename, do double-click on the name with the left mouse 

button, the Text Editor window will appear, then rename, click OK). The structure of 

the server room is presented in  Figure 1.7. 

  

Fig. 1.7. The structure of the server room 
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Let's connect the hubs and the servers. According to the structure of the 

network (see Figure 1.1), place all the hubs. According to the 10BaseFL standard, the 

physical topology is a star, so we connect the hubs from Building 2 and Building 3 to 

the hub in Building. To do this, open the rooms in which they are situated (Figure 

1.8). 

  

Fig. 1.8. Rooms with hubs 

Click on на  on the toolbar (above), click on one hub and then on the other; 

the Link Assistant window will be opened (Figure 1.9). 

  

Fig. 1.9. Work with the Link Assistant window 
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In the Link Assistant window, choose 10BaseFL port for the first and second 

hubs and click Link button. The value of Length is set of 200 m (distance between 

houses 200 m); Protocol – Ethernet 10BASE-F; Media – Fiber Optic Cable; 

Bandwidth – 10 Mbit/s; click Close button, as shown in Figure 1.10. 

  

Fig. 1.10. Task parameters of the campus subsystem 

Next, connect all servers to the hub (similar to connecting two hubs). The value 

of Length is set of 1 m (server and hub are situated in the same room); connect them 

with twisted-pair cable (Figure 1.11). 

3.3. Determining the threshold of the network performance on the 

simulation model. To determine the performance threshold, you must add one 

workstation to the network and configure/adapt data transfer to the servers for each 

workstation. To add a workstation you need to go to a room, for example to Room 3 

on the panel Devices (on left): LAN workstation, press once with the left mouse 

button; drag the workstation into the room from the Devices panel . 
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Fig. 1.11. Setting the parameters of the horizontal subsystem 

Connect the workstation to the hub located in this building (similar to 

connecting the server to the hub). Taking into accouny the width and height of the 

floor, set the Length (according to the variant it is 3 m), using twisted-paired cable. 

To configure/adapt data transfer on the toolbar (above), press ; then on the 

workstation, and on the server to which we send data; the Profiles window will be 

opened, which is shown in Figure 1.12. 

  

Fig. 1.12. Working with Profiles window 

In the Profiles window, choose the item which name matches the name of the 

server, for example, HTTP client, then click Assign. To start the simulation model, 

press . The movement of the packets will be displayed on the model. If in the 

network appears  anywhere, it means that the network has fallen. In our case, the 

network fell with the number of stations 36 (Figure 1.13), i.e. the threshold of the 

network is 35 workstations. 
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Fig. 1.13. The fall of the network on the simulation model 

3.4. Conducting experiments on the Ethernet simulation model. The 

following conditions must be met during the experiment: the simulation model must 

work for 7 minutes; packets of volum from 500 to 1000 bytes are transmitted; every 

0,02 s by exponential law. To adjust the sizes of the packets and their sending interval 

you should do the follows: Global (in the main menu) → Data Flow; choose the 

workstation, click Edit, Profile window will be opened in which you need to select 

the type of server (e.g. Small office database server's client) to which the traffic is 

assigned; click Edit, the window Small office database server's client will be opened, 

where you need to set the appropriate parameters, this is shown in Figure 1.14. 

  

Fig. 1.14. Work with the window Small office database server's client 

After all the settings you need to record the statistics. The conditions of the 

experiment must be maintained when running all subsequent simulation models. 
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To get statistics on the Ethernet simulation model you need opt in the main 

menu: Tools → Reports → Wizard; the Select a report window will appear, in which 

you should select Statistical → LAN → LAN Segments Statistics to obtain the 

statistics of the average load of network equipment; the corresponding window will 

be opened, in which without changing anything press the Next button three times, 

then click Done (Figure 1.15). 

  

Fig. 1.15. Work with the LAN Segments Statistics Report Wizard 

As a result, we obtain the report LAN Segments Statistics, Figure 1.16. 

 

Fig. 1.16. The report LAN Segments Statistics  
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The figure shows that the load on the central hub is 100 %, and the other two is 

30 %. To determine the response time for the data flow and traffic destination, select: 

Statistical → Data Flows → Applications Statistics; the received report is shown in 

Figure 1.17. 

 

Fig. 1.17. Applications Statistics Report 

The figure shows that the maximum response time is 23 minutes. 

To remove the network characteristics of a particular part of the network (e.g. 

server room) select: Advanced → Modules → Module Statistical Items; the 

corresponding window appears (Figure 1.18). 
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Fig. 1.18. Work with the Module Statistical Items Report Wizard window 

Select the server room Room 2, and then opt Devices. As a result, the report 

Module Statistical Items is built, Figure 1.19. 

 

Fig. 1.19. The Module Statistical Items report 

The Module Statistical Items report describes all the parameters of the Room 2 

equipment. 

In general, the following statistics are obtained on the simulation model of the 

designed Ethernet network (Figure 1.20). 
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Рис. 1.20. Statistics of the Ethernet network 

Draw appropriate conclusions. Enter the values of the main characteristics 

(response time, network load, communication equipment load) obtained on the 

Ethernet simulation model to the summary table. 

Laboratory work № 2 

CONSTRUCTION OF LOCAL NETWORK SIMULATION MODEL USING 

SWITCHED ETHERNET TECHNOLOGY 

Objective:    1. Get acquainted with Switched Ethernet technology. 

2. To study the general and distinctive properties of the bridge and the 

switch. 

3. Acquire practical skills of logical structuring of Ethernet network. 

1. Individual task 

Problem statement: on the basis of the given infrastructure (according to the 

variant of the individual task), design with the help of the NetCracker Pro program a 

network on the basis of the Switched Ethernet technology, estimate its loading, 

response time, and cost. 

2. The sequence of execution 

1. Get acquainted with the Ethernet technology (frame formats, the necessary 

condition for recognizing the collision in the network, the collision domain). 

2. Study the purpose of communication equipment of network logical 

structuring, general and distinctive properties of the bridge and switch. 

3. Substantiate the need of solving the problem of logical structuring of the 

Ethernet network (from the Lab № 1). 

4. Analyze the location of the required number of communication equipment for 

the logical structuring of the Ethernet network. 

5. Calculate the cost of the built Switched Ethernet network. 

6. Run on the simulated model of the Switched Ethernet network. Analyze the 

average load of network equipment and data transmission environment as well as the 

response time for the data flow. 

7. Compare the obtained characteristics (cost, response time and load) of the 

Ethernet and Switched Ethernet networks. 

8. Prepare a report on laboratory work: 
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– theme and purpose of laboratory work; 

– substantiation of the required amount of communication equipment and its 

brief characteristics; 

– the structure of the Switched Ethernet network (with indication of the 

distances, the locations of servers and the communication equipment); 

– calculation of the cost of the Switched Ethernet; 

– print out the report with the estimated average load of the network equipment 

and the data transmission environment as well as the response time for the data flow; 

– conclusions. 

9. Present simulation models built in lab № 1–2 to the teacher on the computer. 

10. Prepare to defend the topic Ethernet Technology. 

3. Example of laboratory work (option № 43) 

3.1. Development of the Switched Ethernet network structure. As the 

number of stations increases (see Lab № 1), the Ethernet network fails, so it is 

necessary to solve the problem of its logical structuring using a switch. We enter the 

switch into the Building, because there is the largest load; all hubs and servers are 

connected to the switch. The structure of the projected Switched Ethernet network is 

shown in Figure 2.1.  

 

Fig.2.1.The structure of the projected network Switched  Ethernet 
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When entering a switch with 11 ports, 11 collision domains are formed: 8 

domains when connecting servers (each of the servers is connected directly to the 

port); 3 domains when connecting hubs (workstations are connected to the port 

through the appropriate hub). 

3.2. Construction of a simulated Switched Ethernet network in the 

NetCracker package. Copy the file in which the Ethernet simulation model is 

located (Lab1). For logical structuring of the Ethernet network, the DEC switch 400 

LAN Switch is selected with the following parameters: bandwidth is 2,5 Gbit/s; delay 

is 40 (мкс); promotion speed and packet filtering speed are 14880 packets/s; the total 

number of ports is 11 (9 are used for 10Base-T and 2 for 10Base-F). 

To place the switch in Room 2 select the follows: Switches → Ethernet (token 

ring) to ATM → Digital Equipment → DEC switch 400 LAN Switch; click once 

with the left mouse button on the name; drag the switch  to Room 2 from the 

Devices panel (on left). Add modules to the switch: DESSL-EA (8 10Base-T ports); 

DESSM-AA (1 port 10Base-T); 2 DESSM-AC modules (one 10Base-F port in each 

module). Disconnect the server and the hub from the hub in Room 2; this can be done 

by double-click of left button of the mouse on the cable that has to be removed. A 

window will appear in which you need to click Unlink (Figure 2.2); the connection 

will disappear. We run a simulation model; the model must work without failures. 

  

Fig.  2.2. Working in the "Link Assistant" window 

3.3. Conducting experiments on the simulation model Switched Ethernet. 

To compare the resulting characteristics of networks of different technologies, the 

start of the simulation model Switched Ethernet must be performed at a certain 

threshold of the Ethernet (number of workstations is 35). The conditions of the 
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experiments must coincide with the conditions of the experiment on the simulation 

model Ethernet (network time, size of the packets, packet sending intervals). 

The LAN Segments Statistics report obtained on the Switched Ethernet 

simulation model is shown in Figure 2.3. 

 

Fig. 2.3. LAN Segments Statistics Report 

The figure shows that the load of the central hub in the Switched Ethernet 

network has dropped more than twice compared to the load of the same hub in the 

Ethernet network.. The Report Statistics report on the Switched Ethernet simulation 

model is shown in Figure 2.4. The figure shows that the maximum response time in 

the Switched Ethernet network is 12 minutes, which is about twice less than in the 

Ethernet network (where the maximum response time is 23 minutes).  

 

Fig. 2.4. The Applications Statistics Report 
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The Module Statistical Items report of the Switched Ethernet server room is 

shown in Figure 2.5. 

 

Fig. 2.5. The Module Statistical Items Report 

Compared to the Ethernet network, the total network load dropped from 100 % 

to 43 %; the response time decreased by almost 2 times. 

Make appropriate conclusions. Enter the values of the main characteristics (the 

response time, the network load, the communication equipment load) obtained on the 

simulation model of the Switched Ethernet network in the final table. 

Laboratory work № 3 

CONSTRUCTION OF SIMULATION LOCAL NETWORK MODEL BY 

FAST ETHERNET TECHNOLOGY 

Objective:  1. Get acquainted with Fast Ethernet technology. 

 2. Examine the limitations of the Fast Ethernet physical layer 

specifications. 

3. Master the method of estimating the configuration of the Fast 

Ethernet network. 

4. Acquire practical skills of physical structuring of the network. 

1. Individual task  

Problem statement: on the basis of the given infrastructure (according to the 

variant of the individual task) to design a network on the basis of Fast Ethernet 

technology, to estimate its loading, response time and cost. 
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2. The sequence of execution 

1. Get acquainted with Fast Ethernet technology (general and distinctive 

properties of Fast Ethernet from Ethernet, the limitations of the standards of the 

physical level of Fast Ethernet). 

2. Make the transition to Fast Ethernet technology: justify the choice of physical 

environment for horizontal, vertical and campus subsystems. 

3. Perform an analysis of all limitations of the standards in accordance with the 

chosen physical environment; justify the choice of communication equipment for 

physical structuring of the Fast Ethernet network. 

4. Check the correctness of the configuration of the received network. 

5. On the simulation model to determine the "threshold" of the network. 

6. Calculate the cost of the built Fast Ethernet network. 

7. Run on the simulation model of the Fast Ethernet network. Analyze the 

average load of network equipment and data transmission medium, as well as the 

response time for the data flow. 

8. Prepare a report on laboratory work: 

– theme and purpose of laboratory work; 

– initial and additional data; 

– substantiation of the required amount of communication equipment and its 

brief characteristics; 

 – structure of the Fast Ethernet network (with indication of distances, locations 

of servers and communication equipment); 

 – calculation of the correctness of the configuration of the Fast Ethernet 

network; 

 – found the "threshold" of the Fast Ethernet network; 

 – calculation of the cost of the Fast Ethernet network; 

 – printout of the report with the definition of the average load of network 

equipment and data transmission medium, as well as the response time for the data 

flow; 

 – conclusions. 

9. Prepare to defend the topic "Fast Ethernet Technology". 

3. Example of laboratory work (option № 43) 

The physical structuring of the Fast Ethernet network should be based on the 

"single repeater" rule (Figure 3.1) or the "two repeater" rule (Figure 3.2). 
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 Fig. 3.1. Fast Ethernet network structure based on one repeater 

Consider the first approach (Figure 3.1): when using a multiport repeater Fast 

Ethernet Class I, the size of the conflict zone is 200 + 200 = 400 m (distance between 

buildings 200 m), and the maximum value of the conflict zone 260,8 m; this means 

that it is impossible to build a Fast Ethernet network. 

Consider the second approach (Figure 3.2): when using two multiport Fast 

Ethernet Class II repeaters, the size of the conflict zone is 200 + 200 + 5 = 405 m 

(distance between houses 200 m, distance between repeaters 5 m), and the maximum 

value of the conflict zone 216,2 m; this means that it is impossible to build a Fast 

Ethernet network. 
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Fig. 3.2. The structure of the Fast Ethernet network based on two repeaters 

Laboratory Work № 4 

CONSTRUCTION OF SIMULATION LOCAL NETWORK MODEL 

BY SWITCHED FAST ETHERNET TECHNOLOGY 

Objective:  1. Get acquainted with the Switched Fast Ethernet technology. 

2. Study the general and distinctive properties of the I and II class 

repeaters. 

3. Acquire practical skills of logical structuring of the Fast Ethernet 

network. 

1. Individual Task 

Problem statement: on the basis of the given infrastructure (according to the 

variant of the individual task) design a network on the basis of Switched Fast 

Ethernet technology with the help of the NetCracker Pro program, estimate its 

loading, response time and cost.  
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2. The Sequence of Execution 

1. Get acquainted with Fast Ethernet technology (class I and II repeaters, logical 

redundant codes). 

2. Substantiate the need to solve the problem of logical structuring of the Fast 

Ethernet network (from the laboratory work № 3). 

3. Analyze the location of the required number of communication equipment for 

logical structuring of the Fast Ethernet network. 

4. Calculate the cost of the built network Switched Fast Ethernet. 

5. Run on the simulation model of the Switched Fast Ethernet network. Analyze 

the average load of network equipment and data transmission environment as well as 

the response time for the data flow. 

6. Compare the obtained characteristics (cost, response time and load) of 

Switched Ethernet and Fast Ethernet networks. 

7. Compare the obtained characteristics (cost, response time and load) of the 

Fast Ethernet and Switched Fast Ethernet networks. 

8. Prepare a report on the laboratory work: 

– the theme and the purpose of the laboratory work; 

– the substantiation of the required amount of the communication equipment 

and its brief characteristics; 

– the Switched Fast Ethernet network structure (with indication of the 

distances, the locations of the servers and the communication equipment); 

– the calculation of the cost of Switched Fast Ethernet; 

– the printout of the report with the definition of the average load of the 

network equipment and the data transmission medium as well as the response time 

for the data flow; 

– the conclusions. 

9. Provide the teacher with computer simulation models built in the laboratory 

works № 1–3. 

10. Prepare to defend the topic Fast Ethernet Technology. 

3. Example of laboratory work (option № 43) 

3.1. Development of the Switched Ethernet network structure. It is necessary 

to solve the problem of the logical structuring of the Fast Ethernet network using a 

switch. The structure of the corresponding network is presented in Figure 4.1. 
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Fig. 4.1. The Switched Fast Ethernet network structure 

With the introduction of the network switch, 11 conflict zones emerged: one 

conflict zone when connecting the hub to the Building; two identical zones of conflict 

when connecting hubs with Building 2 and Building 3; eight identical zones of 

conflict when connecting servers. 

Estimation of the size of the conflict zone. For example, for a conflict zone based 

on Building 2, the following paths should be considered: the distance between the 

most remote workstations in the zone (Ethernet Workstation 22 and Ethernet 

Workstation 24); the path on which the repeaters are concentrated; the distance 

between the farthest station (Ethernet Workstation 22) and the switch. 

Ethernet Workstation (22) → Ethernet Workstation (24) = 11+11=22 m; 

Ethernet Workstation (22) → Switch Fast Ethernet = 211 m; 

Ethernet Workstation (22) → Switch Fast Ethernet = 211 m; 

max{22; 211; 211} = 211 м < 260,8 m. 

Estimation of the value of PDV. For example, for the conflict zone in Building 2: 

PDV1 = 464,264140100112,1221 =++=PDV  bt; 

232,4521401001200112,1112 =+++=PDV  bt; 
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232,4521401001200112,1113 =+++=PDV  bt < 512 bt. 

The conflict zone in Building 3 coincides with the conflict zone in Building 2. 

For the conflict zone in the Building, the size of the conflict zone and the value of 

PDV must be determined separately. 

Estimate the size of the Building conflict zone:  

Ethernet Workstation (16) → Ethernet Workstation (18) = 7+7=14 m; 

Ethernet Workstation (16) → Switch Fast Ethernet = 7 m; 

Ethernet Workstation (16) → Switch Fast Ethernet = 7 m; 

max{14; 7; 7}= 7 m < 200 m. 

Estimation of the value of the PDV Building: 

568,255140100112,1141 =++=PDV  bt; 784,247140100112,172 =++=PDV  bt; 

784,247140100112,173 =++=PDV  bt, отже max{255,568; 247,784; 247,784}= 

255,568 bt < 512 bt. 

The server conflict zones are completely the same, so the conflict zone 

definition and the PDV value are calculated once. 

Estimation of the size of the server conflict zone: Ethernet Server → Switch 

Fast Ethernet = 1 m; max 1} = 1 m < 200 m. 

3.2. Building a simulation model of the Switch Fast Ethernet network in 

NetCracker Pro. Copy the file in which the simulation model Switched Ethernet is 

located (Lab № 2). 

All Ethernet hubs need to be replaced with Class I Ethernet Multiport 

Repeaters. For the Fast Ethernet specification on 100Base-TX twisted pair, 100Base-

FX fiber optic cable. 

Class I Ethernet Rackmound Hubs FEH-16s is used as a Class I repeater, which 

is located: Alloy Computer Products → Fast Ethernet Rackmound Hubs FEH-16s; 

add the Fiber Optic Uplink Port module. The repeater has 16 100Base-TX ports and 1 

100Base-FX port; the maximum delay is 1,4 μs. 

Replace the Ethernet switch with a Fast Ethernet switch. As a switch we use 

BayStack 450-12-T, which is located: Switches → Workgroup → Ethernet → Bay 

Network → BayStack 450-12-T; add the BayStack 400-2FX 2-port 100Base-FX 

module. The switch has 12 ports for 100Base-TX and 2 ports for 100Base-FX. 

When connecting workstations to the repeater, you need to make the settings 

shown in Figure 4.2. 
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Fig. 4.2. Setting the parameters of the vertical subsystem 

The same settings are used for connecting servers to the switch. 

By connecting the repeaters (Building 2 and Building 3) with the switch 

(Building), the settings are performed as follows (Figure 4.3). 

  

Fig. 4.3. Setting the Campus settings 

Since the Class I repeater is selected, it is necessary to set the corresponding 

delay equal to 1,4 μs (delay for the Class I repeater is 140 bt, 1 bt = 0,01 μs, ie 140 bt 
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= 1,4 μs). Do a click of the right button of the mouse on the repeater: Properties → 

Telecom → Latency. The result is shown in Figure 4.4. 

  

Fig. 4.4. The Class I repeater delay task 

We are launching a simulation model Switch Fast Ethernet. The model must 

work without failures. 

3.3. Conducting experiments on the simulation model Switch Fast 

Ethernet. The start of the Switch Fast Ethernet simulation model is performed at a 

certain Ethernet performance threshold (35 workstations). The experiments are carred 

out under the same conditions as in previous simulation models (network uptime, 

packets size, packet sending interval). 

The LAN Segments Statistics report obtained from the Switched Fast Ethernet 

simulation model is shown in Figure 4.5. 

 

Fig. 4.5. The LAN Segments Statistics Report 

The figure shows that the load of the central hub in the Switch Fast Ethernet 

network compared to Ethernet (100 %) and Switched Ethernet (43 %) fell to 4 %. 
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The Applications Statistics report is shown in Figure 4.6. 

 

Fig. 4.6. Applications Statistics Report 

The figure shows that the maximum response time in Switched Fast Ethernet is 

7 minutes, which is 42 % less than that ones in Switched Ethernet (maximum 

response time is 12 minutes), and 3 times less than in Ethernet. 

The Module Statistical Items report of the server room is shown in Figure 4.7. 

 

Fig. 4.7. Module Statistical Items Report 
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Compared to Ethernet (100 %) and Switched Ethernet (43 %), the overall load 

of the Switch Fast Ethernet network dropped to 4 %. 

Draw the appropriate conclusions. Enter the values of the main characteristics 

(response time, network congestion, communication equipment congestion) obtained 

on the simulation model of the Switched Fast Ethernet network in the final table. 

Laboratory Work № 5 

CONSTRUCTION OF SIMULATION MODEL OF LOCAL NETWORK 

USING TOKEN RING TECHNOLOGY 

Objective:  1. Get acquainted with Token Ring technology. 

2. Study the features of marker access methods. 

3. Acquire practical skills in solving the problem of physical structuring 

of the Token Ring network. 

1. Individual Task 

Problem statement: on the basis of the given infrastructure (according to the 

variant of the individual task) with the help of NetCracker Pro, to design a network 

on the basis of Token Ring technology, to estimate its loading, response time, and 

cost. 

2. The Sequence of Execution 

1. Get acquainted with Token Ring technology (logical and physical topology of 

the network; the retention time and the maximum turnover of the marker; the diagram 

of the channel level states by the marker method of the access to the ring; the data 

frame formats and the marker). 

2. Study the purpose of the communication equipment for physical structuring of 

the network. 

3. Get from the teacher a variant of the individual task (Table 4-6). 

4. Choose a physical environment for horizontal and vertical subsystems and 

campus subsystems; justify the choice. 

5. Perform an analysis of all standards constraints according to the chosen 

physical environment; justify the choice of communication equipment for the 

physical structuring of the Token Ring network. 

6. Determine the "threshold" of the Token Ring network on the simulation 

model: the number of workstations, the intensity of requests, the length of the frame. 

7. Calculate the cost of the built network Token Ring. 

8. Start the simulation model of the Token Ring network. Analyze the average 

load of the network equipment and data transmission environment as well as the 
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response time for the data flow. Specify areas of the network that are vulnerable to 

congestion. 

9. Make a report on the laboratory work: 

 – topic and purpose of laboratory work; 

 – initial and additional data; 

– substantiation of the required amount of the communication equipment and 

its brief characteristics; 

– structure of Token Ring network (with indication of distances, locations of 

servers and communication equipment); 

– found the threshold of the Token Ring network; 

– calculation of the cost of the Token Ring network; 

– printout of the report with the definition of all characteristics; 

– conclusions. 

10. Prepare to defend the topic Marker Technologies. 

3. Example of laboratory work (option № 43) 

3.1. Development of the structure of the Token Ring network. For the 

Campus subsystem, the best type of cable is fiber optic; for vertical and horizontal 

subsystems, one of the possible options is using UTP Cat 3. 

The first step is to determine if it is possible to build a computer network using 

Token Ring technology without hubs/concentrators. When directly connecting 

workstations to the ring, the length of the physical segment is 200 m + 7 m = 207 m 

which exceeds the maximum length of the physical segment of the network that is 

100 m. It is necessary to carry out the physical structuring of the Token Ring 

network, the structure of the corresponding network is presented in Figure 5.1. 

Since the maximum cable length between the hubs concentrators is 45 m and the 

distance between the houses is 200 m, 3 hubs concentrators are connected to each 

other in a ring (the distance between them is 20 m), and the other three of them 

connect the houses to the logic ring. Therefore, 6 hubs concentrators (MSAUs) must 

be installed between the buildings, which are interconnected via Ring In / Ring Out 

(RI / RO) ports. 

SuperStack LinkBuilder FMS TR 24 Stackable Hub and 16 Meg Token Ring 

Repeater Module are used to build a simulation network model. The main parameters 

of these hubs concentrators: bandwidth is 16 Mbps, the number of ports SuperStack 

LinkBuilder FMS TR 24 Stackable Hub is 27, of which 13 are used; number of ports 

16 Meg Token Ring Repeater Module is 3 ports; filtering speed is 400,000 packets/s, 

data rates are 4 and 16 Mbps. 
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 Fig. 5.1. Physical structuring of the Token Ring network  

3.2. Construction of a simulation model of the Token Ring network. Start Net 

Cracker Pro. Create a new project: File → New ( ). Save the project immediately: 

File → Save ( ), select a folder to save and click OK. When creating a project, the 

Top window will open. In the Devices tab (on the left side of the panel), select 

Buildings, Campuses and LAN workgroups. From the bottom of the window, drag 

the Campus ( ) to the clear field of the Top window. To place houses on campus, 

right click on Campus and select Expand from the context menu. A new Campus 
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window will be opened. From the bottom panel (Devices tab), drag  to the clear 

field of the Campus window. Thus, the campus subsystem is created (Figure 5.2). 

  

Fig. 5.2. Creating a Campus subsystem 

It is necessary to make three floors in each house ( , Figure 5.3), with three 

rooms on each floor ( , Figure 5.4). 

            

Fig. 5.3. Creating a vertical subsystem Fig. 5.4. Creating a horizontal subsystem 

The structure of the network can be viewed on the Project Hierarchy tab in the 

left panel (Figure 5.5). 

  

Fig. 5.5. Hierarchy of network simulation model 
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To build a simulation model of the Token Ring network, you must use Token 

Ring Server servers which are located on the Devices → Lan Servers tab  ( ); 

Token Ring Workstations which are also located on the Devices tab → Lan 

Workstations ( ).  

Install the server software as follows: Devices → Network and Enterprise 

software → Server Software ( ). 

Hubs located in vertical subsystems are as follows (Figure 5.6): Devices → 

Hubs → Shared Media → Token Ring → 3Com Corp. → SuperStack LinkBuilder 

FMS TR 24 Stackable Hub. 

  
Fig. 5.6. Hub for the vertical subsystem 

MSAU required in the campus subsystem is as follows (Figure 5.7): 

Devices → Hubs → Shared Media → Token Ring → Black Box Corp. 

  
Fig. 5.7. Hub for campus subsystem 
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Set the logical ring that is located in the Devices tab → Generic LANs → 

Token Ring ( ).  

Connect the hubs, servers and workstations according to the network structure 

(see Figure 5.1). To do this, click  on the toolbar, then on the workstation, then on 

the hub; the Link Assistant window will be opened. 

In the Link Assistant window (Figure 5.8) select the Token Ring ports for the 

workstation and the hub; set the cable length in the Length field (for example, 3 m to 

connect the workstation in Room 8 to the hub); data transfer rate from the list in the 

Bandwidth field (4 or 16 Mbps); Media → Twisted Pair; Protoсol → Token Ring and 

click Link. 

  

Fig. 5.8. Setting the parameters of the horizontal subsystem 

Similarly, connect the server to the hub (Figure 5.9). 
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Fig. 5.9. Task parameters of the campus subsystem 

3.3. Determining the threshold of the Token Ring network performance on 

the simulation model. To determine the performance threshold, you must add one 

workstation to the network and configure the data transfer to the servers for each 

workstation. To configure data transfer press  on the toolbar (above); on the 

workstation, and then on the server to which we send data; the Profiles window will 

be opened, which is shown in Figure 5.10. 

  

Fig. 5.10. Working with the Profiles window 

In the Profiles window, select the item whose name matches the server name, 

such as the FTP client, and click Assign. 

Run the simulation model by clicking Start ( ). The movement of the 

packets is displayed on the model. If   appears somewhere in the network, the 
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network is congested (Figure 5.11), ie the threshold of the Token Ring network is 7 

stations.  

  

Fig. 5.11. The fall of the Token Ring network at 8 stations 

Therefore, the Token Ring simulation model will not be able to work with 35 

workstations (this is the Ethernet performance threshold found in Lab № 1). 

3.4. Conducting experiments on the simulation model Token Ring. The 

conditions of the experiment on the simulation model Token Ring are the same as in 

the Laboratory Work № 1: the simulation model should work for 7 minutes; the 

packets from 500 to 1000 bytes are transmitted; every 0,02 s by exponential law. 

To get network statistics, use the Report Wizard: Tools → Reports → Wizard. 

In the window Select a report (Figure 5.12) select LAN → LAN Segment Statistics. 

  

Fig. 5.12. Working with the Select a report window 
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As a result of the Master's work we get the report "LAN Segment Statistics", 

which is presented in Figure 5.13. 

 

Fig. 5.13. LAN Segment Statistics Report 

The figure shows that the occupancy of the Token Ring is 19 % which is 

approximately 1,8 times bigger than the occupancy of the Ethernet network. 

To determine the maximum network response time for a data stream and to 

assign traffic in the Select a report window you should opt: Data Flows → 

Application Statistics. The resulting report is shown in Figure 5.14. 

 

Fig. 5.14. Application Statistics report for Token Ring network 
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The figure shows that the maximum response time for the Token Ring network 

is 86 ms (with 7 workstations) which is approximately 2,15 times longer than on the 

Ethernet network: the response time of the Ethernet network with 7 workstations is 

40 ms (Figure 5.15) . 

 

Fig. 5.15. Application Statistics Report for Ethernet 

To obtain the network characteristics of a particular part of the network (for 

example, the server room), in the window Select a report you should opt: Modules → 

Module Statistical Items and select the desired room. As a result, the report "Module 

Statistical Items" is built (Figure 5.16). 

  

Fig. 5.16. The report Module Statistical Items for the Token Ring network 

The figure shows that the load of the hub from the server room is 17,3225 % 

which is approximately 2 times less than in the Ethernet network: the load of the hub 

from the server room for the Ethernet network is 35,2168 % (Figure 5.17). 
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Fig. 5.17. Module Statistical Items report for Ethernet 

Enter to the final table the values of the main characteristics (maximum 

response time, network load, equipment load) obtained on the simulation model of 

the Token Ring network; draw appropriate conclusions. 

Laboratory Work № 6 

CONSTRUCTION OF SIMULATION LOCAL NETWORK MODEL USING 

SWITCHED TOKEN RING TECHNOLOGY 

Objective:  1. To get acquainted with the performance characteristics of switches. 

            2. To study the structural diagrams of networks on switches. 

3. Acquire practical skills of logical structuring of the Token Ring 

network. 

1. Individual Task 

Problem statement: on the basis of the given infrastructure (according to the 

variant of the individual task), to design with the help of the NetCracker Pro program 

a network on the basis of Switched Token Ring technology, to estimate its loading, 

response time and cost. 

2. The Sequence of Execution 

1. Get acquainted with Token Ring technology (the algorithm for an early 

release of the marker; the mechanism for setting the priorities and their processing; 

the control procedures). 

2. Study the purpose of the communication equipment of the logical structuring 

of the network, the general and characteristic properties of the bridge and switch. 

3. Substantiate the need to solve the problem of the logical structuring of the 

Token Ring network (from the Lab № 5). 

4. Analyze the location of the required number of th ecommunication 

equipment for the logical structuring of the Token Ring network. 

5. Calculate the cost of the built network Switched Token Ring. 
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 6. Run the simulation model of the Switched Token Ring network. Analyze 

the average load of the network equipment and the data transmission environment, as 

well as the response time for the data flow. 

7. Compare the obtained characteristics (the cost, the response time and the 

load) of Token Ring and Switched Token Ring networks. 

8. Make a report on laboratory work: 

– topic and purpose of laboratory work; 

– substantiation of the required amount of th communication equipment and its 

brief characteristics; 

– structure of the Switched Token Ring network (with indication of the 

distances, the locations of the servers and the communication equipment); 

– calculation of the cost of the Switched Token Ring network; 

– printout of the report with the definition of the average load of the network 

equipment and the data transmission environment, as well as the response time for 

the data flow; 

– make conclusions. 

9. Provide the teacher with the computer simulation models built in the 

Laboratory Works № 5, 6. 

10. Prepare to defend the topic Marker Technologies. 

3. Example of laboratory work (variant № 43) 

3.1. Development of Switched Token Ring network structure. For the 

campus subsystem, the best type of cable is fiber optic; for the vertical and 

horizontal subsystem one of the possible is UTPCat3. 

To build the simulation network model Super Stack Link Builder FMS TR 

24 Stack Able Hub, 16 Meg Token Ring Repeater Module and Link Switch 2000 

TR Switch are used. The main parameters of these hubs: bandwidth is 16 Mbit/s, 

number of Super Stack Link Builder FMS TR 24 Stack Able Hub is 27 ports of 

which 13 are used; number of ports is 16 Meg Token Ring Repeater Module and 3 

ports are used; filtering speed is 400,000 packets/s, data rates are 4 and 16 Mbps. 

Switch parameters are as follows: number of ports is  12 (10 are used), delay 

is 10 μs, frame rate is 14880 frames/s, MAC address table size is 2048, bandwidth 

is  3,2 Gbps. The structure of the Switched Token Ring network is presented in 

Figure 6.1. 
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Fig. 6.1 Logical structuring of the Token Ring network 

Symbols: fiber optic cable; twisted steam; TRW – Token Ring Workstation 

 

3.2. Construction of a simulation model of the Switched Token Ring 

network. We take as a basis the simulation model of Lab № 5 to which we need to 

add a switch. 

Launch Net Cracker Pro. We open the project of Laboratory Work № 5. Next 

you need to install the switch: Switches → Workgroup → Token Ring → 3 Com 

Corp. → SuperStack LinkSwitch 2000 TR Switch. Select it in the panel and move it 

to the work area. Connect the switch to the hub "SuperStack II Hub TR 24" which is 

located in Building 2 (as shown in Figure 6.2.) and to the MSAU concentrator. 

Assign traffic as it is done in the Lab № 1. 



 46 

 

Fig. 6.2. Hub connection with switch 

The conditions of the experiment are similar: the simulation model should 
work for 7 minutes; the packets from 500 to 1000 bytes are transmitted; every 0,02 s 
by exponential law. Number of stations in the Switched Token Ring network is 7 
(found threshold of the Token Ring network, Lab № 5). 

To obtain network statistics, use the Report Wizard: Tools → Reports → 

Wizard. In the Select a report window, select LAN → LAN Segment Statistics. As a 

result of the Master's work we get the report "LAN Segment Statistics" which is 

presented in Figure 6.3. 

 

Fig. 6.3. LAN Segment Statistics Report 

The figure shows that the network load of the Switched Token Ring fell to 4 %  

compared to Switched Ethernet (35 %) and Token Ring (19 %). 
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To determine the maximum response time of the Switched Token Ring 

network for data flow and traffic assignment in the Select a Report window: Data 

Flows → Application Statistics. The result report is shown in Figure 6.4. 

 

Fig. 6.4. Application Statistics Report 

The figure shows that the maximum response time for the Switched Token 

Ring is 31 ms which is 10 ms faster than the Switched Ethernet network (41 ms) and 

55 ms faster than the Token Ring network (86 ms). 

To obtain the network characteristics of a particular part of the network (for 

example, the server room), in the window "Select a report": Modules → Module 

Statistical Items and select the desired room. As a result, the report "Module 

Statistical Items" is built (Figure 6.5). 

  

  

Fig. 6.5. Module Statistical Items Report 

The figure shows that the hub load from the server room is 11,792 % which is 

5,6 % less than in the Token Ring network (17,322 %), and 23,2 % less than in the 

Switched Ethernet network (35 %). 

The values of the main characteristics obtained on the simulation model of the 

Switched Token Ring network should be entered in the final table. 
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Laboratory Work № 7 

CONSTRUCTION OF SIMULATION NETWORK MODEL 

USING FDDI TECHNOLOGY 

Objective:  1. To get acquainted with the technology of the marker method of access 

to the FDDI ring. 

2. Learn the types of node connections and FDDI port types. 

3. Acquire practical skills in building a simulation model of the FDDI 

network. 

1. Individual Task 

Problem statement: on the basis of the given infrastructure (according to the 

variant of the individual task) to design a network on the basis of FDDI technology, 

to estimate its loading, response time and cost. 

2. The Sequence of Execution 

1. Get acquainted with FDDI technology (general and characteristic features of 

FDDI from Token Ring, types of node connections and types of FDDI ports). 

2. Make a partial transition to FDDI technology: justify the choice of physical 

environment for horizontal, vertical, and campus subsystems. 

3. Perform an analysis of all limitations of the standards in accordance with the 

chosen physical environment; justify the choice of the communication equipment of 

the FDDI network. 

4. Determine the threshold of the network on the simulation model. 

5. Calculate the cost of the built network. 

6. Run a simulation network model. Analyze the average load of the network 

equipment and the data transmission environment as well as the response time for the 

data flow. 

7. Compare the obtained characteristics (cost, response time and load) of the 

Switched Fast Ethernet network and the FDDI network. 

8. Prepare a report on laboratory work: 

– topic and purpose of laboratory work; 

– initial and additional data; 

– structure of FDDI network (with indication of distances, locations of servers 

and communication equipment); 

– found the threshold of the FDDI network; 

– calculation of the cost of the FDDI network; 

– printout of the report with the definition of the average load of network 

equipment and data transmission environment as well as the response time for the 

data flow; 
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– conclusions. 

9. Present to the teacher the simulation models built in Lab № 6-7 on the 

computer. 

3. Example of Laboratory Work (variant № 43) 

3.1. Development of the FDDI network structure. The fiber cable is the 

selected for horizontal, vertical, and campus subsystems. The FDDI network includes 

a double ring one of which is primary and the other is secondary. In the FDDI 

network, a single connection (Single Attachment, SA) or a dual connection (Dual 

Attachment, DA) to the ring is possible. With a single connection, the stations are 

connected only to the primary ring, with a double connection – to the primary and 

secondary rings. Depending on whether the node is a hub or end station, you can 

select the following designations depending on the type of connection: end station 

with a single connection Single Attachment Station (SAS); Dual Attachment Station 

(DAS); Single Attachment Concentrator (SAC); Dual Attachment Concentrator 

(DAC). In the designed network we use only DAC and SAC. The structure of the 

corresponding network is presented in Figure 7.1.  

  
Fig. 7.1. The structure of the projected FDDI network 

 

The use of FDDI ports of different types is shown in Figure 7.2. 
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 Fig. 7.2. Using different types of FDDI ports 

The network uses a LinkBuilder FDDI Hub (16-ports). It is advisable to place 

all servers in one room (server room); it is located in Building (floor 2, room 2); see 

Lab № 1). 

3.2. Building a simulation model of the FDDI network in NetCrackerPro. 

Start the program: Create a new project: File → New ( ). Save the project 

immediately: File → Save ( ), select a folder to save and click OK. When creating 

a project, the Top window will open. In the Devices tab (on the left panel), select: 

Buildings, campuses and LAN workgroups. Drag the campus ( ) from the 

bottom of the window  to the clear field of the Top window.  

To place houses on campus, you need to right-click on Сampus and select 
Expand from the context menu. A new Campus window will be opened. From the 
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bottom panel (Devices tab), drag  to a clear field of the Campus window. Thus, 
the result of the action is presented in Figure 7.3. 
 

  

Fig. 7.3. Creating a Campus subsystem 

By analogy, you need to make three floors in each house ( , Figure 7.4) 

with three rooms on each floor ( , Figure 7.5). 

                        

Fig. 7.4. Creating a vertical     Fig. 7.5. Creating a horizontal 

subsystem      subsystem  

To install a double ring in the FDDI simulation model opt the follows: Devices 

→ Generic LANs → FDDI ( ). 

The structure of the FDDI network can be viewed on the Project Hierarchy tab 

(left panel) as shown in Figure 7.6. 
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Fig. 7.6. The structure of the network 

Eight FDDI-Servers (according to the variant) from the LAN servers panel (on 

the left) must be placed in the server room. 

Click once on LAN servers; drag the FDDI-Server from the bottom into the 

room eight times. Now you need to make servers for a specific purpose. To do this, 

insert a specific disk into the server: Network and enterprice software → Server 

software. Left-click once on the Server software, several disks will appear at the 

bottom, from which we need: two File servers, one FTP server, two HTTP servers 

and three Small office database servers. 

Add one disk to each server and rename the server accordingly (to rename, 

double-click on the name with the left mouse button, the Text Editor window will 

appear, rename, click OK). The set of received servers is presented in Figure 7.7. 

  

Fig. 7.7. The composition of the server room 

In the server room (with the Expand command), put the hub LinkBuilder FDDI 

Hub   (left panel: Devices → Hubs → Shared Media → FDDI → 

3ComCorp.); click once on the title and drag the bottom of the hub into the room. 
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You need to add modules with slots to the hub: three LinkBuilder FDDI Fiber Optic 

Modules. To add a module to the hub, you need to drag the module to the hub from 

the bottom panel. To view, double-click the hub with the mouse or right-click using 

the Configuration command. Place the hub in the server room. As a result, the 

LinkBuilder FDDI Hub has three modules, as shown in Figure 7.8. 

  

Fig. 7.8. LinkBuilder FDDI Hub structure 

Let's connect hubs and servers. According to the structure of the network (see 

Figure 7.2) we place all hubs. The physical topology of the FDDI network is a double 

ring of trees, so each hub is connected to a ring, as shown in Figure 7.2. To do this, 

open the rooms in which they are situated (Figure 7.9). 

  

Fig. 7.9. Rooms with hubs 
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On the toolbar (at the top) click on , then click on one hub and then on the 

other; the LinkAssistant window will be opened (Figure 7.10). 

  

Fig. 7.10. Working with the LinkAssistant window 

The FDDI port is selected in the LinkAssistant window (default); click the 

Link button. The value of Length is set to 100 m (distance between houses is 200 m); 

Protocol is FDDI / CDDI; Media is Fiber Optic Cable; Bandwidth is 100Mbit/s; click 

the Close button. 

3.3. Determining the network performance threshold on the FDDI 

simulation model. To determine the performance threshold, you must add one 

workstation to the FDDI simulation model and configure data transfer to the servers 

for each workstation. 

To add a workstation, you need to go to a room, for example in Room 3 in the 

panel Devices (on the left), and opt: LAN workstation, press once with the left mouse 

button; from the Devices panel (at the bottom) drag the workstation  into the 

room. Connect the workstation to the hub located in this building (similar to 

connecting the server to the hub). Considering the width and height of the floor, set 

the Length (according to the variant of 3 m). 

To configure the data transfer on the toolbar (above), press ; then press  the 

workstation, and then  the server to which we send data; the Profiles window will be 

opened which is shown in Figure 7.11. 
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Fig. 7.11. Working with the Profiles window 

In the Profiles window, select the item whose name matches the server name, 

for example, HTTP client, then click Assign. To start the simulation model, press the 

button . The movement of packets will be displayed on the model. If the button  

 appears anywhere in the network, it means that the network has crashed. In our 

case, the network fell with the number of stations 264 (Figure 7.12), i.e. the threshold 

of the network is 409 workstations. 

  

Fig. 7.12. The fall of the network on the simulation model 
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3.4. Conducting experiments on a simulation model. The following 

conditions must be met during the experiment: the simulation model must work for 7 

minutes; packets from 500 to 1000 bytes are transmitted; every 0,02 s by exponential 

law. To adjust the packet size and sending interval you should opt: Global (in the 

main menu) → DataFlow; select the workstation, click Edit, the Profile window will 

be opened in which you need to select the type of server (e.g. Small office database 

server's client) to which the traffic is assigned; click Edit, the window Small office 

database server's client will be opened, where you need to set the appropriate 

parameters, this is shown in Figure 7.13. 

  
Fig. 7.13. Working with the window Small office database server's client 

After all the settings, you need to obtain the statistics on the FDDI simulation 

model. For this aim, do the follows in the main menu: Tools → Reports → Wizard; 

the window Select a report will be opened in which to obtain statistics of the average 

load of the network equipment, select LAN Segments Statistics; the corresponding 

window will be opened, in which without changing anything click Next three times, 

then click Done (Figure 7.14). 

  

Fig. 7.14. Working with the LAN Segments Statistics Report Wizard 
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As a result, we obtain the report LAN Segments Statistics, which is presented in 

Figure 7.15. 

 

Fig. 7.15. LAN Segments Statistics Report 

At the threshold found on the Ethernet simulation model (35 workstations; see 

Lab № 1), the network load is 11 % as shown in Figure 7.16; this is almost 3 times 

more than the load of the Switched Fast Ethernet network (4 %). 

The response time for the data flow and the traffic assignment is determined 

using the Applications Statistics item; the obtained report on the FDDI simulation 

model is shown in Figure 7.16. 

 

Fig. 7.16. Applications Statistics Report 
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The figure shows that the maximum response time is 2 minutes which is 

almost 4 times less than the maximum response time of the Switched Fast Ethernet 

network (7 minutes). 

To remove the network characteristics of a particular part of the network (e.g. 

server room), select Module Statistical Items; the corresponding window will be 

opened (Figure 7.17). 

  

Fig. 7.17. Working with the Module Statistical Items Report Wizard 

Select the server room Room 2, and then opt  Devices. As a result, the report 

Module Statistical Items is built which is shown in Figure 7.18. 

 

Fig. 7.18. Module Statistical Items Report 
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The following statistics were obtained on the simulation model of the designed 

computer network FDDI (Figure 7.19). 

 Fig. 7.19. The FDDI network statistics for 35 workstations 

Compared to the Switched Fast Ethernet network, the total network load 

increased from 4 % to 11 %; the response time decreased by almost 4 times. 

Record the results obtained on the FDDI and SwitchedEthernet simulation 

models in the final table; draw appropriate conclusions. 

Conclusions 

On the created simulation models of a local area network on various 

technologies at identical initial parameters and identical conditions of carrying out 

experiments the network characteristics which analysis allows to argue a choice of 

network technology are received. 
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